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 Introduction to RealPlayer
Welcome to the RealPlayerÔ 5.0 by RealNetworks. RealPlayer is the premier real-time audio and video delivery 
system for the Internet. 

Using RealPlayer, you can listen to and view thousands of hours of live and pre-recorded clips, including 
sporting events, live radio stations, news, music, lectures, and RealFlash animation. In addition, RealPlayer 
includes several different RealPlayer components and provides links to several World Wide Web sites loaded 
with exciting RealMedia content.

Visit RealNetworks' website for updated information at http://www.real.com.

See Also:
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Using RealPlayer
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 RealPlayer Components
In addition to RealPlayer, several different special-purpose RealPlayer components are installed on your 
computer. The components work with different elements within World Wide Web pages to deliver RealMedia 
content in a variety of ways. The RealPlayer components are:

RealPlayer Plug-in The Plug-in provides access to RealMedia programming 
and extends the audio and video capabilities of your 
Netscape browser (Netscape Navigator 2.0 or later). 

RealPlayer Control for 
ActiveX

The RealPlayer Control for ActiveX provides access to 
RealMedia programming and extends the audio and 
video capabilities of your Internet Explorer browser and 
Visual Basic applications.

RealAudio Xtra for 
Shockwave

The RealAudio Xtra for Shockwave provides RealAudio 
programming within a Macromedia Shockwave movie.

 Overview of RealPlayer
The RealPlayer enables you to experience RealMedia files over the Internet or over a local area network in real 
time, without downloading the clip to your hard drive. When you click a RealMedia link from a World Wide Web 
page, your RealPlayer automatically opens and plays the file you have selected.

Overview of RealPlayer



Section Description
Play/Pause Button Click this button to play or pause a clip, depending on 

the status of the clip. 

Stop Button
Click the  button to stop the clip. 

Position Slider The slider moves as a clip is being played. You can fast 
forward or rewind to a different section of the audio clip 
by dragging the slider.

Fast Forward/Rewind Buttons
Click either the  button or the  button to fast 
forward or rewind the clip in 10-second intervals.

Link to the RealNetworks 
Home Page If you are connected to the Internet, click the  

button to link to the RealNetworks Home Page. 

Image Window If you are playing a video clip, the image appears in this 
window.

Destination Buttons Click these buttons to quickly access interesting 
RealAudio or RealVideo content.

Title, Author and Copyright 
Text

The content provider specifies the text in these fields; 
they normally describe the clip being played.

Volume Control The volume control indicates the volume at which the 
clip is being played. Increase the volume by dragging the
control up, and decrease the volume by dragging the 
control down.

Mute Button
Click the  button to silence the audio portion of the 
clip. The clip continues to play. Click this button again to 
hear the audio portion of the clip.

Status Bar The status bar displays information about the player and 
the clip, including: 

Indicates the clip currently being played is stereo.

Indicates the clip currently being played is mono.

Green lightning bolt indicates some loss of playback 
quality due to quality of connection.

Red lightning bold indicates poor playback quality due to
quality of connection. 

Indicates that the RealPlayer is buffering the stream.

Indicates that the network is busy and the player is 
buffering more data.

00:00.0/00:00.0 The elapsed time (the length of time that the clip has 
been playing) and the total time (the length of the entire
clip).

Note: When playing a live stream, Total Time value is 
replaced by the word live.

Status This is a one line informational display that gives the 
current status of the Player, and explains menu options.

Zoom Button
Click the  button to open a menu where you can 



choose to double the video image area, enlarge the 
image area to full screen, or return the image area to 
normal size.

Compact Controls Button
Click the  button to display a limited number of the 
controls in the window. Click the Enlarge button to 
display all of the controls.

See Also:
RealPlayer Menus 
Using RealPlayer 
Troubleshooting 



 RealPlayer Menus
The RealPlayer has five menus: File, View, Clip, Sites, and Help. These menus allow you to take full advantage of
RealPlayer features.

See Also:

File Menu 
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Clip Menu 
Sites Menu 
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 File Menu
Commands from the File menu allow you to play RealMedia files without using your World Wide Web browser to 
find files on the Internet, and to exit RealPlayer. 

Menu Option Description
Open Location Select this option to play RealAudio files through the 

Internet without using your World Wide Web browser. In
the Open Location dialog, enter the URL (Internet 
address) of a .rm, .ra, or .ram file.

Open File Select this option to play a local RealAudio or RealVideo
file. When the Open File dialog appears, select 
a .rm, .ra, or ram or file stored on your computer.

Open Recent Select this option to view a list of recently played clips. 
You can select a clip from this list to hear or view the 
clip again.

Exit/Quit Select this option to exit RealPlayer.

 View Menu
Commands from the View menu allow you to control the appearance, to customize the operation, and view the 
performance of RealPlayer.

Menu Option Description
Normal Select this option to display all of the buttons and 

controls on RealPlayer; a mark appears next to the 
option. 

Compact Select this option to display only the image area (if 
playing a RealVideo or Flash clip), a subset of the 
buttons and a reduced Status bar.

Auto-Size Select this option to display only the image area (if 
playing a RealVideo or Flash clip) when the cursor is not
over the RealPlayer window; a mark appears next to 
the option. When the cursor is on the window, the 
Compact controls are displayed.

Destinations Select this option to display the destination buttons on 
the RealPlayer window; a check mark appears next to 
the option. Select the option again to hide the 
information; the check mark is removed.

Info & Volume Select this option to display the volume control, and the
title, author, and copyright information for the clip; a 
check mark appears next to the option. Select the 
option again to hide the information; the check mark is 
removed. 

Status Bar Select this option to display the Status Bar; a check 
mark appears next to the option. Select the option 
again to hide the bar; the check mark is removed. 

Preferences Select this option to display the Preferences window for
configuring RealPlayer. You can set preferences from 
this window. Refer to Setting Preferences for more 
information.

Statistics Select this option to display transmission quality 
information in the Connection Statistics dialog. The 
Connection Statistics window reports the performance 
of the Internet connection between the RealAudio or 



RealVideo Server and RealPlayer.

Always on Top
(Windows only)

Select this option to make RealPlayer remain on top of 
all other windows, even when another window is active;
a check mark appears next to the option. Always on Top
is convenient for keeping RealPlayer visible while you 
interact with your World Wide Web browser. Select this 
option again to allow other windows to open on top of 
RealPlayer; the check mark is removed.

 Clip Menu
Some RealMedia files can include several clips played one after the other. Commands from the Clip menu allow 
you to move between clips in a multi-clip RealMedia (.ram) file and when scanning. This scanning is similar to 
using seek buttons on a CD player. If there is only one clip at the link you are accessing, these options are not 
available.

Previous Clip and Next Clip are also available from the shortcut menu that appears when you right-click the 
mouse button in RealPlayer window.

Menu Option Description
Previous Clip Select this option to play the previous clip in a multi-

clip (.ram) file or when scanning.

Next Clip Select this option to play the next clip in a multi-clip 
(.ram) file or when scanning.

 Sites Menu
Commands from the Site menu allow you to access various World Wide Web sites. This feature works with 
popular World Wide Web browsers. If you are connected to the Internet, and your World Wide Web browser is not
open, RealPlayer opens it for you.

Note: You must be connected to the Internet in order to reach these sites.

Menu Option Description
Real Home Page Select this option to access the RealNetworks' Home 

Page.

Real Content Select these options to access sites that feature 
RealMedia.

Timecast: Your RealMedia 
Guide

Timecast contains a list of World Wide Web sites 
providing RealMedia content.

MusicNet MusicNet contains a directory of RealMedia happenings 
in the music world.

LiveConcerts.com LiveConcerts.com is the premiere site for live music 
events broadcast on the Internet using RealMedia.

Film.com Film.com provides an unprecedented collection of 
material on film for a world-wide audience, offering 
breadth and depth, and bringing together critics, 
writers and movie buffs everywhere.

DailyBriefing.com DailyBriefing.com is where you build your own 
customized video and audio daily newscast, choosing 
from the best news, sports, business, technology, 
entertainment, and music programs on the Web.



Customize RealPlayer Select these options to customize your RealPlayer 
content buttons.

Customize Daily Briefing Build a custom newscast with stories from well-known 
news and entertainment organizations.

Destinations Tutorial Select this option to access a page where you can learn
how to set your preset and destinations buttons.

Customize Destinations Select this option to access a page where you can 
customize your destination buttons.

 Help Menu
Commands from the Help menu provide online help and information about RealPlayer.

The latest support and technical information is available at: 

http://service.real.com

Please refer to the enclosed Technical Support Card for more information on contacting RealNetworks Technical 
Support.

Menu Option Description
Contents Select this option to open the online help for RealPlayer.

Common Questions Select this option to access the RealNetworks 
Frequently Asked Questions page. You must be 
connected to the Internet for this option to work.

Search Knowledge Base Select this option to access the RealNetworks 
knowledge base and search for the answer to a 
question. You must be connected to the Internet for this
option to work.

Service & Support Select this option to access the main RealNetworks 
Technical Support and Service page. You must be 
connected to the Internet for this option to work.

Full Screen Help Select this option to access RealNetworks' Full Screen 
and DirectDraw information page.

Check for Upgrade Select this option to query the RealNetworks home 
page for upgrade information. A dialog box appears 
telling you if there is an upgrade available.

About Select this option to display RealPlayer version and 
Copyright information.

 Using RealPlayer
RealPlayer enables you to click a RealMedia link from your Web browser and begin playing clips instantly, 
without download delays. In addition, you can pause, rewind, fast-forward, stop, and start the clip at a click of a 
button.

See Also:

Starting a Clip 
Pausing a Clip 
Stopping a Clip 
Muting a Clip 
Changing the Size of RealPlayer Window 



Changing the Size of the Image Area 
Setting Your Destination Buttons



 Starting a Clip
There are several ways to start playing a RealAudio or RealVideo clip:

· Click a RealMedia link on a World Wide Web page. Your World Wide Web browser opens RealPlayer and 
the clip is streamed to RealPlayer immediately. After storing a few seconds of the clip (buffering), the 
playback begins.

· Access a World Wide Web site or select an action that automatically plays a clip. Your World Wide Web 
browser opens RealPlayer and the clip is streamed to RealPlayer immediately. After storing a few seconds 
of the clip (buffering), the playback begins.

· Click one of the Destination buttons on RealPlayer. The clip is streamed to RealPlayer immediately. After 
storing a few seconds of the clip (buffering), the playback begins.

· Click Open File or Open Location on the File menu on RealPlayer. For more information, refer to File 
Menu.

See Also:
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 Pausing a Clip

You can pause a clip while it is playing by clicking the  button. This halts the stream. If you want to 
resume the clip at the same point it was paused, click the 

 button again.
If you pause a clip but do not resume playing after several minutes, the server may terminate your connection. 
The length of time you can pause a clip without your connection terminating depends on the particular server.

See Also:

Starting a Clip 
Stopping a Clip 
Muting a Clip 
Changing the Size of RealPlayer Window 
Changing the Size of the Image 
Setting Your Destination Buttons



 Stopping a Clip
You can stop a clip while it is playing by clicking the  button. The clip stops playing. To play the clip again 
from the beginning, click the 

 button.
See Also:

Starting a Clip 
Pausing a Clip 
Muting a Clip 
Changing the Size of RealPlayer Window 
Changing the Size of the Image Area 
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 Muting a Clip
You can mute a clip while it is playing by clicking the  button. The clip continues to play but does not play the
audio.

See Also:
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 Changing the Size of RealPlayer Window
Do one of the following:

· Click the button to display the RealPlayer in Compact view. This view displays a subset of buttons, a 
smaller status bar and the image window (if not playing an audio-only clip).

· From the View menu, select the appropriate option to modify the size of the RealPlayer window. 
· Normal displays all the controls and buttons.
· Compact displays a select group of buttons: 

· Auto-Size looks like Compact when the cursor is over the window and only displays an 
image window (if playing a non audio-only clip) when the cursor is not over the window.

· Click the button to display the RealPlayer in Compact view. This view displays a subset of buttons, a 
smaller status bar and the image window (if playing a non audio-only clip).

Note: If the video or RealFlash clip won't fit on your RealPlayer screen using the current settings, RealPlayer will
ask if you would like your settings changed automatically.

· Select Yes if you want RealPlayer to automatically change your settings.
· Select No if you don't want RealPlayer to automatically change your settings.
· If you want RealPlayer to always resize in this situation, select Please don't ask me again, and then 

select Yes.
· If you don't want RealPlayer to offer this option, select Please don't ask me again, and then select No.

See Also:
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 Changing the Size of the Image Area
You can enlarge the size of a video or RealFlash clip image to double size. In addition, you can enlarge the size 
of a video clip image to full screen size. However, this increases the processing time required for playback. If 
your playback quality decreases or if your machine seems overloaded, you should return the clip image back to 
original size.

Note: In order to use the Full Screen feature, you must have Microsoft DirectX Tools with DirectDraw, and recent
video drivers, installed on your machine. For information on downloading and installing the most recent version 
from Microsoft's web site, see How do I get Full Screen to work?  or select Full Screen Help from the RealPlayer
Help menu.

Before you can use the Full Screen feature, the Player will ask you to run a short test to see if your DirectX and 
video drivers are functioning properly. The test involves switching into Full Screen mode for 5 seconds. Then, 
you are asked to confirm whether you saw the RealPlayer logo in Full Screen mode. If yes, then the Player 
resumes the clip, switches to Full Screen mode, and you will not be asked to run the test in the future. If no, 
then you are asked if you would like to refer to RealNetworks' Full Screen and DirectDraw information page.

To increase the image area to double size:

1. Click the  button.
You will see a pop-up menu with zoom options.

2. Select the Double Size option from the menu.
To return to original size from double size:

1. Click the  button.

2. Select the Original Size option.

To increase the image area for video clips to full screen:

1. Click the     button.
2. Select the Full Screen option from the menu. The image will cover your screen entirely. Click anywhere on
the screen to return to original size.

Note: When you choose the Full Screen option, sometimes the image is surrounded by a black border. This is 
normal for clips that have odd height-to-width ratios.

See Also:
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 Setting Your Destination Buttons
Your RealPlayer comes with six buttons that you can customize to access premium content with a push of a 
button.

To customize the Destination buttons:
· Click one of the buttons. RealPlayer opens your default browser to the Customize Destinations page 

(http://www.real.com/destinations). Follow the directions on that page.

To play Destination buttons content:
· Click the appropriate button. RealPlayer plays the associated file. 

See Also:
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 Setting Preferences
You can customize RealPlayer by changing the settings in the Preferences window (opened from the View 
menu). The Preferences control various aspects of RealPlayer applications functionality, such as the number of 
clips to remember, network information, and proxy information. These preferences apply to all applications 
using RealPlayer technology.

See Also:

General Preferences 

Connection Preferences 

Transport Preferences 

Proxy Preferences 

Advanced Preferences 

Language Preferences 

Upgrade Preferences 



 General Preferences
The General tab in the Preferences window contains preferences for number of clips saved on the Open Recent 
menu, Synchronized Multimedia support, and BufferedPlay. 

Field Description
Recent Clips You can quickly replay clips by clicking Open Recent on 

the File menu. This setting controls how many clips are 
displayed in the Open Recent menu.

Synchronized Multimedia Some RealMedia clips contain synchronized multimedia 
events that display pages or images in your web 
browser. This setting controls whether RealPlayer 
applications enable these events.

BufferedPlay RealPlayer applications allow playback of higher quality 
clips on lower bandwidth connections with the 
PerfectPlay feature. This setting controls how much of 
the clip is buffered before beginning playback.

 Connection Preferences
The Connection tab in the Preferences window contains information about your bandwidth, statistics, and 
network timeout.

Field Description
Bandwidth RealPlayer applications automatically select which 

content can be delivered in real time over your 
connection. This setting controls the bandwidth of the 
content selected.

Statistics RealPlayer applications maintain statistics on connection 
quality. These statistics help content providers improve 
the quality of their service. This setting controls whether 
statistics are sent to the content provider.

Note: RealPlayer does not send the content provider any
information about your identity (your user name or e-
mail address).

Network Timeout These settings control how long RealPlayer applications 
wait to receive data before considering a network 
connection to have failed. Increase the values if you 
frequently receive timeout errors.

 Transport Preferences
The Transport tab in the Preferences window allows you to customize your network connection for RealPlayer. 
Most likely, if you are connecting to the Internet through a commercial ISP, you do not have to set any of the 
items on this tab.

The description of these preferences assumes a basic knowledge of Internet protocols and firewalls. For more 
information about firewalls, refer to our World Wide Web site at:

http://www.real.com/help/firewall

Field Description
Network Transport RealMedia clips can be transmitted to your computer 

via several different network transports. This setting 



controls how these network transports are selected.

Automatically select most 
efficient transport

Use this setting if you are not aware of any problems 
that require you to specify a transport method.

Click the Auto Configure button to have RealPlayer 
automatically configure itself to use the most efficient 
mode of transport for your connection.

Use specified transports Use this setting if your computer has problems using 
some network transports. (Consult your network 
administrator for the appropriate setting.)

Click the Specify Transports button to access the 
Specify Transports window. Refer to Specify Transports 
Window.

UDP Port Some networks have limited ports available for Internet
applications. This setting controls which port RealPlayer
applications use for receiving data. (Consult your 
network administrator for the appropriate setting.)

Note: This setting does not affect TCP packets, which 
can only be received through Port 7070.

 Specify Transports Window
The Specify Transports window allows you to select the different modes of network transports that you can 
receive. (Consult your network administrator for the appropriate setting.)

Field Description
Use TCP to Connect to 
Server

Select this option if you want RealPlayer to use TCP for 
the initial connection to RealServer.

Attempt to use Multicast 
for live content

Select this option if you want RealPlayer to attempt to 
receive live content through multicast. 

If you select this option, indicate how many 
milliseconds the Player should attempt to use this type 
of transport before switching to UDP.

Attempt to use UDP for 
static content and for live 
content not available via 
Multicast

Select this option if you want RealPlayer to attempt to 
use UDP for static content and live content not 
available via multicast.

If you select this option, indicate how many 
milliseconds the Player should attempt to use this type 
of transport before switching to TCP.

Attempt to use TCP for all 
content

Select this option if you want RealPlayer to use TCP for 
all content.

Use HTTP Only Select this option if you are behind a firewall and 
cannot receive data through TCP. All data will be 
streamed through HTTP.

Note: You may not be able to receive some content if 
you select this option.



 Proxy Preferences
A proxy is a server that acts as an intermediary between a company's protected LAN (local area network) and 
the Internet. The proxy server insures that all data transmission between the Internet and a user on the LAN is 
authorized. RealPlayer can be configured to work with proxy servers by setting the proxy preferences.

For more information about proxies and firewalls, read:

http://www.real.com/help/firewall

Field Description
Use Proxy Click this box if RealPlayer applications should connect 

to the Server using a proxy; a check mark appears in 
the field. Otherwise, do not click this box.

Note: If you are behind a firewall and do not know the 
host name or port number of your proxy server, ask 
your system administrator.

RealPlayer Proxy Enter the domain name or IP address of the RealPlayer 
proxy server and port number that RealPlayer 
applications should use to communicate with the proxy 
server. 

Note: For information on RealPlayer Proxy, read:
http://www.real.com/help/firewall

HTTP Proxy Enter the domain name or IP address of the HTTP proxy 
server and port number that RealPlayer applications 
should use to communicate with the proxy server. Check
your World Wide Web browser's proxy configuration.

No Proxy for: [Host1, 
Host2¼]

If you have specified that RealPlayer applications should
be connected to the Server using a proxy, you can 
specify certain local hosts (domain names or IP 
Addresses) with which you do not need to communicate 
using the proxy server. Enter these hosts in this field. 
This field is only available if you have enabled the Use 
Proxy option.

Your system administrator can provide you with this 
information, if appropriate.

 Advanced Preferences
Options on the Advanced tab of the Preferences window override RealPlayer defaults for sound card 
compatibility, for CPU and memory requirements, for Zoom specifications, and for system tray use.

Field Description
Audio Playback 
Performance

RealPlayer uses this setting to optimize the performance 
of clip playback. Change this performance setting only if 
your computer seems sluggish or has problems while 
playing some audio content.

Sound Card Compatibility
(Windows only)

Modify sound card settings to overcome audio problems.

Disable 16-bit sound
(use 8-bit only)

Use this setting if you have an older sound card and clips
sound scratchy or distorted.

Disable custom sampling
rates 

Use this setting if clips play at the wrong speed or sound 
scratchy or distorted. (Requires a floating point 



coprocessor.)

Zoom Click the Zoom button to open a window where you can 
select Zoom specifications.

Allow content providers 
to specify zoom mode

Content providers can specify a Zoom mode, causing the
Player to zoom to a larger size automatically. Select this 
option if you want content providers to specify zoom 
mode.

By default, this option is selected.

Never prompt when 
content will not fit on 
screen

When a clip will not fit on your screen, RealPlayer will ask
if you want to automatically resize your window. Select 
this option if you don't want RealPlayer to prompt you 
when content will not fit on your screen using the current
settings.

For more information, see Changing the Size of the 
Image Area.

System Tray Select this option if you want RealPlayer to stay resident 
on your system, creating an icon in your system tray. 
With this option selected, you will be able to quickly 
access RealPlayer.

By default, this option is selected.

 Language Preferences
The setting on the Language tab of the Preferences window determines the language used within the RealPlayer
applications.

Field Description
Current Language This field displays the language being used within 

RealPlayer applications.

Installed Languages Select the language you want to use within RealPlayer 
applications.

Note: Please contact RealNetworks regarding 
information on languages available for RealPlayer 
applications.

Upgrade Preferences
Using the Upgrade tab of the Preferences window, you can customize how often the application queries the 
RealNetworks home page to check for available upgrades. 

Field Description
Upgrade Notification RealPlayer periodically contacts the RealNetworks web 

site to determine if a newer version is available. When a 
newer version is available, RealPlayer alerts you and 
provides a link to a web site where you can download the
new Player.

If you do not want RealPlayer to check for upgrades, 
check the Disable Automatic Upgrade Notification 
button.

Check for Upgrade 
Availability

Click this button to check for any available RealPlayer 
upgrades.





 Troubleshooting
For the latest information on RealMedia products, visit the RealNetworks home page at:

http://www.real.com

A technical knowledge base, frequently asked questions list and technical library are available from our web site
at:

http://service.real.com

Please refer to your Technical Support Card for more information on contacting RealNetworks Technical Support.

See Also:

How do I configure my browser to support RealMedia?  

How do I get Full Screen to work?  

What's wrong when the playback is poor?  

Why doesn't my RealPlayer have a Volume Control slider?  

Why can't I play RealAudio or RealVideo clips on my computer at work?  



 How do I configure my browser to support RealMedia?
With most browsers, RealPlayer installation configures the browser to support RealMedia playback. If you 
change your browser and it stops recognizing RealMedia files, reinstall RealPlayer. To manually configure your 
World Wide Web browser, do the following:

1. Open the Options, Preferences or Settings menu. 

2. Select the Helper Applications or a similar option. 

3. Look for "audio/x-pn-realaudio" in the File type list. If that entry exists, select that entry. 

Otherwise, click New Type. Enter audio as the Mime Type. Enter x-pn-realaudio as the Mime SubType. 
Click OK. 

4. Enter rm, ra, ram in the Extensions field. 

5. Select the Launch Application option. Browse and find the directory in which RealPlayer is installed. (By 
default, the RealPlayer is installed in c:\Real\Player\)

6. Select RealPlayer (realplay.exe) as the application to launch.

For more information, refer to the following page:    http://service.real.com/help/faq/index.html.



 How do I get Full Screen to work?
If you are having problems with Full Screen (e.g. only a black screen appears), make sure that you have the 
following installed on your machine:

· Microsoft DirectX Tools with DirectDraw

You can download the most recent version and installation instructions from RealNetworks' DirectDraw 
support page (http://service.real.com/fullscreen/default.html). When you install DirectX, you must choose to
upgrade your video drivers. You may lose old functionality of your drivers, however.

· Updated video drivers

You can find these either from the company that manufactured you video card or from RealNetworks' 
DirectDraw support page (http://service.real.com/fullscreen/default.html). If you update your video drivers, 
you may lose old functionality of your drivers.



 What's wrong when the playback is poor?
The expected playback quality varies depending on bandwidth and the encoding algorithm you are playing. If 
the quality is garbled, choppy, or skips, use the following to isolate and correct the problem. 

If the quality was poor when the Thankyou.rm file played at the end of the RealPlayer installation, you have a 
sound card conflict. Try changing the settings on the Advanced tab in the Preferences window. Refer to 
Advanced Preferences.

If the quality was good when the Thankyou.rm file played at the end of the RealPlayer installation, but is bad 
at a particular site, use the Connection Statistics window in RealPlayer to check for lost packets. If the packet 
loss is high, it may be due to a busy network. Try to connect to the site at a later time.

If the quality was good when the Thankyou.rm file played at the end of the RealPlayer installation, but sounds 
bad at all sites, complete the following steps.

If the playback quality is poor on every site, do the following: 

1. Check the actual modem connection speed. This may be shown in the lighted display for external 
modems, or through an information window if you have an internal modem (check the user manual for 
your modem). Sometimes service providers use a lower rate connection speed such as 14.4 Kbps, so 
even though you are dialing in on a 28.8 Kbps modem, you are only receiving data at 14.4 Kbps. 

2. If you are using an external modem with a Windows PC and the Connections Statistics window shows 
minimal packet loss (10% or less), there may be a problem with the speed at which packets are 
transferred between the modem and serial card. Try setting the port speed higher (at least twice the 
modem speed).

3. Contact RealNetworks' Technical Support.



 Why doesn't my RealPlayer have a Volume Control slider?
Be sure a check mark appears next to the Info & Volume option on the View menu. If the check mark does not 
appear, click the Info & Volume option.

If the sound card installed in your computer does not support volume control, the Volume Control slider does not
appear on RealPlayer.



 Why can't I play clips on my computer at work? 
If you're on a local area network which is attached to the Internet, and are unable to play RealMedia files from 
remote Web sites, it's possible that your company's firewall is preventing the stream from reaching you. Users 
can receive live and on-demand audio and video from the Internet without exposing their company's network to 
security risks.

If your computer is behind a firewall, please see RealNetworks' firewall page for more information: 
http://www.real.com/help/firewall




